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Einführung
Draw ist ein Zeichenprogramm für Vektorgrafiken. Es kann aber auch Pixelgrafiken erstellen und 
bearbeiten. Draw bietet eine Reihe mächtiger Werkzeuge, die es Ihnen ermöglichen, alle Arten von 
Grafiken schnell zu erzeugen.

Vektorgrafiken bauen ein Bild aus einfachen geometrischen Elementen (Linien, Kreise, Polygone 
usw.) auf und nicht als eine Ansammlung von Bildpunkten (Pixel) auf dem Bildschirm. Dies 
ermöglicht eine einfachere Speicherung und eine präzise Skalierung des Bildes.

Draw ist perfekt in LibreOffice integriert, was den Austausch von Grafiken zwischen allen 
Komponenten von LIbreOffice erleichtert. Falls z. B. ein Bild in Draw erzeugt und in einem Writer-
Dokument verwendet werden soll, können Sie es einfach in die Zwischenablage kopieren und 
dann an der gewünschten Stelle einfügen. Sie können Zeichnungen auch direkt innerhalb von 
Writer und Impress erstellen und verändern, da auch dort die wichtigsten Funktionen und 
Werkzeuge von Draw genutzt werden können.

Der Funktionsumfang von Draw ist sehr umfangreich, auch wenn es nicht mit spezialisierten 
Grafikapplikationen konkurrieren kann. Draw besitzt mehr Funktionen als die meisten 
Grafikprogramme, die üblicherweise (wenn überhaupt) zu Office-Paketen gehören.

Ein paar Beispiele aus der Fülle der Zeichenfunktionen sind im Folgenden aufgeführt: 
Ebenenmanagement, „magnetisches“ Gitterpunktsystem, Dimensions- und Maßstabsanzeige, 
Verbinder für die Erstellung von Organisationsdiagrammen, Bezierkurven, 3D-Funktionen, die es 
ermöglichen, Zeichnungen mit Texturen und Lichteffekten zu erstellen, Integration des Zeichen- 
und Seitenstils, um nur einige zu nennen.

Diese Handbuch ist kein Lehrbuch, das konsequent vom Anfang bis zum Ende durchgearbeitet 
werden muss. Sie müssen also nicht alle Punkte eines Themas durcharbeiten, sondern können 
Abschnitte überspringen und jederzeit abbrechen, wenn Ihre Fragen geklärt sind.

Der Arbeitsplatz
Abbildung 1 zeigt die Draw-Benutzeroberfläche (Arbeitsplatz) mit seinen wichtigsten 
Komponenten.
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Im großen Bereich in der Mitte des Bildschirms werden die Zeichnungen angefertigt. Er ist von 
Symbolleisten und Informationsbereichen umgeben. Deren Anzahl und Position kann individuell 
gestaltet werden. Dies wird im Erste Schritte Handbuch, Kapitel 14 - Anpassen von LibreOffice 
ausführlich erklärt. 

Sie können in Draw Zeichnungen auf mehrere Blätter verteilen. Dies wird hauptsächlich für die 
Erstellung von Präsentationen genutzt, wobei in diesem Fall die Verwendung von Impress, dem 
Präsentationsmodul von LibreOffice, besser geeignet ist. Das Fenster Seitenbereich links in 
Abbildung 1 gibt Ihnen einen Überblick über die verwendeten Seiten. Deren Reihenfolge lässt sich 
durch Drag and Drop ändern.

Lineale
Sie sollten die Lineale an der oberen und linken Seite des Arbeitsplatzes sehen (siehe Abbildung 2 
und 3). Falls die Lineale ausgeblendet sind, können sie unter Ansicht → Lineal aktiviert werden.
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Abbildung 1: Draw nach Start



Die Lineale zeigen Ihnen mit doppelten schwarzen Balken die Lage (Grenzen) des ausgewählten 
Objekts an (siehe Abbildung 3). Wenn kein Objekt angewählt ist, zeigen die Lineale durch einen 
einfachen Strich die aktuelle Mausposition, um Ihnen das genaue Positionieren eines Objektes zu 
erleichtern.

Die Seitenränder im Zeichenbereich werden auch auf den Linealen dargestellt. Um die Maßeinheit 
eines Lineals zu ändern, klicken Sie mit der rechten Maustaste darauf.

Hinweis Sie können auf den beiden Linealen unterschiedliche Einheiten einstellen.

Die Statusleiste
Sie befindet sich wie bei allen LibreOffice-Modulen am unteren Bildschirmrand. 

Im Infobereich wird angezeigt, welche Aktion gerade ausgeführt wird oder welcher 
Objekttyp angewählt (markiert) ist. 

Die Anzeige im Feld Position und Größe erfüllt unterschiedliche Zwecke:
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Abbildung 2: Vertikales und horizontales Lineal

Abbildung 3: Der 
Doppelstrich zeigt die  
Grenzen eines Objektes 
an



• Wenn kein Objekt markiert ist, zeigt das linke Zahlenpaar die Position (Koordinaten) des 
Mauszeigers.

• Während Sie ein neues Objekt mit der Maus aufziehen, zeigt das rechte Feld die aktuelle Größe 
des Aufziehrahmens.

Hinweis
Die Größen werden in der für das gesamte Programm ausgewählten Maßeinheit 
angegeben (nicht zu verwechseln mit den Maßeinheiten der Lineale). Diese 
„Basis-“Einheit wird in Extras → Optionen → LibreOffice Draw → Allgemein definiert, 
wo Sie auch den Zeichnungsmaßstab ändern können.

• Wenn ein Objekt, ausgewählt wird, zeigt das linke Zahlenpaar die linke obere Ecke und das 
rechte Zahlenpaar die Größe des Objekts. Diese Angaben beziehen sich jedoch nicht auf den 
sichtbaren Teil des Objekts, sondern auf sein Auswahlrechteck. Dies ist das kleinstmögliche 
Rechteck, das um das Objekt gelegt werden kann (siehe auch Kapitel 3 dieses Handbuchs: 
Arbeiten mit Objekten und Objektpunkten) .

Wenn ein Objekt markiert ist, öffnet ein Doppelklick auf dieses Feld den Dialog Position und 
Größe. Dieser Dialog wird im Kapitel 4 dieses Handbuches, Objektattribute ändern, ausführlich 
beschrieben.

Die Prozentzahl im Feld Zoom gibt Auskunft über den Zoomfaktor. Dieser kann durch einen 
Doppelklick oder nach einem rechten Mausklick auf dieses Feld schnell geändert werden.

Im Feld Anzeige wird ein  angezeigt, falls das Dokument ungespeicherte Änderungen enthält.

Wenn Sie die Zeichnung mit einer digitalen Signatur versehen wollen, können Sie diese Funktion 
mit einem Doppelklick oder einen rechten Mausklick auf das Feld Signatur aufrufen. Wenn das 
Dokument signiert ist, wird das hier durch ein Symbol angezeigt. 

Das Feld Seite zeigt die Positionsnummer der aktuellen Seite an. Dies ist interessant, wenn Ihr 
Zeichnungsdokument aus mehreren Seiten besteht. Wenn ein Zeichnungsobjekt angewählt ist, 
wird dessen Zeichnungsebene in Klammern angezeigt. Im Beispiel (Abbildung 4) ist es die Ebene 
„Layout“.

Das letzte Feld zeigt an, welche Seitenvorlage für die aktuelle Seite verwendet wird. Mit einem 
Doppelklick auf diese Feld wird ein Auswahlfenster (siehe Abbildung 5) geöffnet und Sie können 
über die Schaltfläche Laden eine andere Vorlage auswählen.
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Abbildung 4



Die Symbolleisten
Die verschiedenen Draw-Symbolleisten können je nach Bedarf angezeigt oder ausgeblendet 
werden.

Um die Symbolleisten anzuzeigen oder auszublenden, klicken Sie einfach auf Ansicht → 
Symbolleisten. In dem Menü, das erscheint, können Sie auswählen, welche Symbolleisten 
angezeigt werden sollen.

Sie können auch die Schaltflächen auswählen, die Sie auf der entsprechenden Symbolleiste 
haben wollen. Im Menü Ansicht → Symbolleisten wählen Sie Anpassen, klicken auf die 
Registerkarte Symbolleisten (siehe Abbildung 6). Wählen Sie nun die gewünschten Schaltflächen 
für diese Symbolleiste aus. Jede Symbolleiste hat eine eigene Liste ihrer Schaltflächen. Sie 
können eine andere Symbolleiste auswählen, wenn Sie im Dropdown-Menü Symbolleiste eine 
andere Symbolleiste auswählen (siehe Abbildung 6)
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Abbildung 5: Folienvorlagen



Die Standardsymbolleiste
Die Standardsymbolleiste sieht folgendermaßen aus :

Die Standardsymbolleiste ist in allen Modulen von LibreOffice identisch und wird deshalb hier nicht 
beschrieben.
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Abbildung 6: Fenster "Anpassen"

Abbildung 7: Abgetrennte Symbolleiste "Standard"



Die Symbolleiste Linie und Füllung
Die Symbolleiste Linie und Füllung ist mitunter eine der  wichtigsten Symbolleisten von Draw. 
Wenn Sie den Mauszeiger über ein Symbol halten, wird deren Funktion eingeblendet. Mit dieser 
Symbolleiste, die standardmäßig unterhalb der Standardsymbolleiste eingeblendet wird, können 
Farbe, Stil und Breite einer gezeichneten Linie oder Füllfarbe, Stil und andere Eigenschaften einer 
Fläche ändern. Das zu ändernde Objekt muss vorher per Mausklick angewählt werden. Falls das 
ausgewählte Objekt Text ist, ändert sich die Anzeige für den Linienstil und die Füllfarbe in 
„unsichtbar“, denn diese Einstellmöglichkeiten beziehen sich nun auf den Textrahmen, der 
standardmäßig unsichtbar ist.

Eine ausführliche Erklärung dieser Symbolleiste finden Sie im Kapitel 4 dieses Handbuches.

Die Symbolleiste Zeichnen
Die Symbolleiste Zeichnen ist die wichtigste Symbolleiste in Draw. Sie enthält alle notwendigen 
Funktionen, um die unterschiedlichsten geometrischen Elemente zu zeichnen. Diese Symbolleiste 
wird im Kapitel 2 dieses Handbuches ausführlicher besprochen.

Die Symbolleiste Farbleiste
Um die Farbleiste anzuzeigen, benutzen Sie Ansicht → Symbolleiste → Farbleiste. Sie erscheint 
dann unten am Arbeitsplatz und zeigt Ihnen die aktuelle Farbtabelle an.

Per Mausklick können Sie so rasch die Farbe für ein Flächen- oder 3D-Objekt wählen. Wenn Sie 
das erste Feld anklicken, wird das Objekt Transparent.

Eine andere Farbtabelle laden
Sie können in Draw auf mehrere spezialisierte Farbtabellen zurückgreifen, jedoch auch einzelne 
Farben verändern. Dazu müssen Sie zuerst den Dialog Fläche aufrufen.

Sie erreichen den Dialog Fläche über Format → Fläche oder durch Anklicken des 
Gießkannensymbols (schwarz unterstrichen) in der Symbolleiste Linien und Füllung, siehe 
Abbildung 8.

Durch Anklicken des Karteireiters mit dem Namen Farben wechseln Sie auf die entsprechende 
Dialogseite.

Um eine andere Farbtabelle zu laden, müssen Sie die Schaltfläche Farbtabelle Laden anklicken 
(siehe Abbildung 10, schwarze Umrandung). Es öffnet sich ein Dateiauswahldialog, in dem Sie aus 
den standardmäßig mit LibreOffice mitgelieferten Farbtabellen (Dateien mit der Endung „.soc“) 
wählen können. Web.soc ist z. B. eine Farbtabelle, die speziell zur Erzeugung von Zeichnungen 
für Webseiten optimiert ist und selbst bei nur 256 verfügbaren Farben richtig angezeigt wird. Eine 
genauere Beschreibung der Farbtabellen und deren Optionen finden Sie im Kapitel 8 dieses 
Handbuchs, „Tipps und Tricks“. 
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Abbildung 8: Abgerissene Symbolleiste "Linie und Füllung" mit unterstrichenen  
Gießkannensymbol



Die Symbolleiste Optionen
Mit dieser Symbolleiste können verschiedene Zeichenhilfen aktiviert oder deaktiviert werden. Die 
Symbolleiste Optionen wird standardmäßig nicht angezeigt. Um sie anzuzeigen, wählen Sie 
Ansicht → Symbolleisten → Optionen.

Die Schaltflächen der Symbolleiste „Optionen“ sind in Abbildung 10 und Tabelle 1 aufgelistet. 
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Abbildung 9: Menü "Fläche -- Reiter " Farben" -- "Farbtabelle laden" hervorgehoben

Abbildung 10: Schaltflächen der Symbolleiste "Optionen"



1. Drehmodus nach Klick auf Objekt 2. Raster Sichtbar

3. Fanglinien sichtbar 4. Hilfslinien beim Hilfslinien beim 
Verschieben

5. Am Raster fangen 6. An Fanglinien fangen

7. Fangen an Seitenränder 8. Fangen am Objektrahmen

9. Fangen an Objektpunkten 10. Schnellbearbeitung zulassen

11. Nur Textbereich selektierbar 12. Text bearbeiten bei Doppelklick

13. Einfache Griffe 14. Große Griffe

15. Objekt mit Attributen ändern 16. Alle Gruppierungen verlassen

Tabelle 1: Funktionen der Symbolleiste Optionen

Raster und Fanglinien

Draw bietet als Zeichenhilfe ein Raster an. Dies kann über die entsprechende Schaltfläche ein- 
oder ausgeblendet werden. Eingeblendete Rasterpunkte werden nicht mit ausgedruckt. Die Farbe 
der Rasterpunkte, ihr Abstand untereinander und ihre Unterteilung kann individuell eingestellt 
werden. Dies wird im Kapitel 8 dieses Handbuchs, Tipps und Tricks (unter „das Raster 
konfigurieren“) ausführlich beschrieben.

Fanglinien sind spezielle Hilfslinien. Auch sie können bei Bedarf ein- oder ausgeblendet werden. 
Draw bietet eine Fangfunktion, mit der Sie Objekte exakt auf diesen Führungslinien platzieren 
können. Auch diese Funktion wird in Kapitel 8 dieses Handbuches beschrieben.

Schwebende und sich bewegende Symbolleisten
Viele Symbole auf der Symbolleiste werden mit einem kleinen Pfeil gekennzeichnet. Der Pfeil zeigt 
an, dass dieses Symbol zusätzliche Werkzeuge bietet.Klicken Sie auf den Pfeil, um alle 
Werkzeuge anzuzeigen (siehe Abbildung 11). Sie können dieses Untermenü abreißen, indem Sie 
auf den unteren Rand der Symbolleiste klicken und den Mauszeiger anschließend an die 
passende Stelle ziehen.

Um eine schwebende Symbolleiste anzudocken doppelklicken Sie auf den Titel der Symbolleiste 
oder ziehen Sie die Symbolleiste an einen Rand des Fensters, bis eine punktierte, rechteckige 
Umrandung erscheint. Um eine verankerte Symbolleiste zu einer schwebenden zu  transformieren, 
klicken Sie auf den Griff und ziehen Sie die Symbolleiste in den Arbeitsbereich hinein (siehe 
Abbildung 12). Alle Komponenten von LibreOffice besitzen schwebende Symbolleisten
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Abbildung 11



Hinweis
Wenn eine Werkzeugsammlung zu einer unverankerten Symbolleiste transformiert 
wird, bleibt das Symbol auf der Symbolleiste und zeigt immer den letzten Befehl an, 
den Sie verwendet haben. Dies bedeutet, dass das Symbol, welches Sie sehen vom 
Symbol, das Sie im Handbuch sehen, abweichen kann.

Tipp

Wenn Sie auf ein Symbol in einer verankerten Symbolleiste doppelklicken, wird der 
Befehl, der diesem Symbol entspricht ausgeführt.Sie können dann diese Aktion so 
oft wiederholen, wie Sie möchten. Um diesen Modus zu beenden, drücken Sie die 
Esc-Taste, oder klicken Sie auf ein anderes Symbol. Dies funktioniert 
möglicherweise nicht für jedes Symbol auf jeder Symbolleiste.

Anpassen von Symbolleisten
Sie können Symbolleisten auf verschiedene Weise anpassen.Das Ein- oder Ausblenden von 
Symbolen,wird in Abbildung 6 auf Seite 10 gezeigt.

Zum Hinzufügen von Funktionen zu einer Symbolleiste, oder um Funktionen zwischen 
Symbolleisten zu verschieben, oder eine neue Symbolleiste zu erstellen, wählen Sie Ansicht → 
Symbolleisten → Anpassen, und wählen Sie anschließend die Registerkarte Symbolleisten 
(Abbildung 13), um die Symbolleiste anzupassen. Klicken Sie auf die Schaltfläche „Neu“, um eine 
neue Symbolleiste zu erstellen. Wählen dann anschließend die gewünschten Schaltflächen für die 
Toolbar aus.
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Abbildung 12



Jede Symbolleiste hat eine andere Liste mit Funktionen. Informationen finden Sie in Kapitel 14 - 
Anpassen von LibreOffice, im Erste Schritte Handbuch. Dieses Kapitel beschreibt auch, wie Sie 
Menüs anpassen können.

1-Klick Druck

Klicken Sie auf das Symbol  Datei direkt drucken , um das gesamte Dokument an den 
Standarddrucker Ihres Computer zu senden.

Hinweis
Sie können die Aktion für das Symbol Datei direkt drucken dazu nutzen, um das 
Dokument an einen anderen Drucker als den Standarddrucker zu senden. Gehen 
Sie dafür Extras → Optionen → Laden/Speichern → Allgemein und wählen Sie die 
Option Druckeinstellungen mit dem Dokument laden aus.

1-Klick Druck 15

Abbildung 13: Menü "Anpassen" -- Register "Symbolleisten"



Kontrolliertes Drucken
Für mehr Kontrolle über drucken, verwenden Sie den Drucken-Dialog (Datei → Drucken oder 
STRG + P).

Hinweis

Im Druckfenster ausgewählten Optionen gelten nur für das Drucken dieses 
Dokuments.
Um die Standard-Druckeinstellungen für LibreOffice anzugeben, gehen Sie zu 
Extras → Optionen → LibreOffice → LibreOffice Draw → Drucken.

Das Drucken-Dialogfeld enthält vier Registerkarten, aus denen Sie viele Optionen ändern können, 
wie es in den folgenden Abschnitten beschrieben wird:

Allgemeine Druckoptionen auswählen
Auf der Registerkarte Allgemein des Dialogfelds Drucken können Sie wählen:

• Den Drucker (aus den verfügbaren Drucker)

• Welche Seiten gedruckt werden sollen, die Anzahl der zu druckenden Seiten, wie viele Exemplare 
gedruckt werden sollen und bei mehreren Exemplaren und Seiten, wie die Seiten sortiert werden 
sollen.

Klicken Sie auf Eigenschaften, um ein Dialogfeld anzuzeigen, in welchen Sie zwischen 
Schwarzweiß und Farbausgabe bzw. zwischen Hoch- und Querformat wechseln können. Auch 
können sie hier die Sortierreihenfolge und das Seitenformat ändern (siehe Abbildung 14)

Auf der Registerkarte Optionen des Dialogfeldes Drucken (Abbildung 15) finden Sie einige seltener 
verwendete Optionen für den Druck.
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Abbildung 14

Abbildung 15: Selten benützte Optionen ändern



Drucken von mehreren Seiten auf einem Blatt Papier
Sie können mehrere Seiten eines Dokuments auf einem Blatt Papier drucken. Um dies zu tun:

1. Wählen Sie im Dialogfeld Drucken den Reiter Seitenlayout

2. Im Abschnitt Layout wählen Sie aus der Dropdown Liste die Anzahl der Seiten pro Blatt .Die 
Vorschau auf der linken Seite der Drucken-Dialog zeigt, wie das gedruckte Dokument aussehen 
wird.

Wenn Sie mehr als zwei Seiten pro Blatt drucken, können Sie die Reihenfolge, in der sie rüber 
und runter drucken festlegen. Die beiden Bilder unten zeigen den Unterschied.

3. Im Abschnitt Bereich und Kopien im Reiter Allgemein wählen sie aus, welche Seiten gedruckt 
werden sollen.

Klicken Sie auf die Schaltfläche Drucken.

Exportieren als PDF
LibreOffice kann Dokumente in das PDF (Portable Document Format) exportieren. Dieser 
Industriestandard ist ideal für das austauschen, da ein PDF-Leseprogramm, wie Adobe PDF 
Acrobat Reader, auf den meisten PCs installiert ist.

Der Prozess und die Dialoge sind grundsätzlich die gleichen, wie für Writer, Calc, Impress. Die 
Draw - spezifischen Unterschiede werden in diesem Abschnitt erklärt.

Direktes Exportieren als PDF

Klicken Sie auf das Direkt exportieren direkt als PDF-Symbol , um das gesamte Dokument mit 
Ihren Standard-PDF-Einstellungen zu exportieren. Sie werden aufgefordert, den Dateinamen und 
Speicherort für die PDF-Datei einzugeben. Allerdings bekommen Sie aber keine Möglichkeit, 
weitere Einstellungen vorzunehmen

Exportieren als PDF
Für mehr Kontrolle über den Inhalt und die Qualität des resultierenden PDF, wählen Sie Datei → 
Exportieren als PDF. Der PDF-Optionen-Dialog öffnet sich. Dieser Dialog hat fünf Seiten 
(Allgemein, Anfangsdarstellung, Benutzeroberfläche, Verknüpfungen und Sicherheit). Wählen Sie 
die entsprechenden Einstellungen, und klicken Sie abschließend auf Exportieren. Im folgenden 
Dialog geben Sie den Speicherort und den Dateinamen des PDF-Dokuments an, welches erstellt 
werden soll an, und klicken anschließend auf Speichern, um das Exportiere als PDF 
fertigzustellen. Weitere Informationen finden Sie in Kapitel 10 - Drucken, Exportieren und E-Mailen 
des Erste Schritte Handbuches

Exportieren in andere Formate
LibreOffice verwendet den Begriff "Export" für einige Datei-Operationen, die eine Änderung des 
Datei-Typs mit sich bringen. Wenn Sie eine Dateiendung im Speichern-Dialog nicht finden können, 
probieren Sie es doch mit dem Export Dialog, den Sie unter Datei → Exportieren finden können.

LibreOffice kann Dateien ins XHTML-Format exportieren. Darüber hinaus kann Draw ins Adobe 
Flash Format (. Swf) und in eine Reihe von Bild-Formate exportieren.
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Um in eines dieser Formate zu exportieren, wählen Sie Datei → Exportieren. Im Export-Dialog, 
geben Sie einen Dateinamen für das zu exportierende Dokument ein, und wählen Sie dann das 
gewünschte Format in der Dateiformat-Liste aus und klicken Sie auf die Schaltfläche Speichern.

Um mehr über das Exportieren von Grafiken zu erfahren, lesen Sie bitte Kapitel 6 - Bilder 
bearbeiten (Rasterbilder) dieses Handbuches.

Hinweis
Der Inhalt der exportierten Datei bezieht sich auf die ausgewählten Elemente der 
Seite. Falls Sie nichts ausgewählt haben wird die gesamte Seite exportiert. Für die 
meisten Export-Formate wird nur die aktuelle Seite beachtet

Exportieren Draw-Dokumente als Webseiten
Um ein mehrseitiges Draw-Dokument in einer Reihe von Web-Seiten exportieren, wählen Sie Datei 
→ Exportieren und wählen Sie HTML-Dokument als Dateityp. Der HTML-Export-Assistent wird 
geöffnet, sobald Sie auf Speichern klicken . Befolgen Sie nun die Eingabeaufforderungen. Wenn 
Sie möchten, kann der Assistent eine Navigationshilfe erzeugen, um die Navigation von Seite zu 
Seite zu vereinfachen.

E-Mail-Dokumente
LibreOffice bietet mehrere Möglichkeiten, um Dokumente schnell und einfach als E-Mail-
Attachment in einem der drei Formate zu versenden: OpenDocument (LibreOffice die Standard-
Format), Microsoft Office-Formate oder PDF.

Hinweis Dokumente können nur mit LibreOffice verschickt werden, wenn ein Mail-Profil 
eingerichtet worden ist.

So senden Sie das aktuelle Dokument im OpenDocument-Format:

1. Wählen Sie Datei → Senden → Dokument als E-Mail. LibreOffice öffnet Ihr Standard-E-Mail-
Programm. Das Dokument ist angehängt.

2. In Ihrem E-Mail-Programm, geben Sie den Empfänger, Betreff und die  Nachricht ein, die Sie 
mitsenden möchten,  und senden Sie anschließend die E-Mail.

Wenn Sie E-Mail als PDF wählen, erstellt LibreOffice zunächst eine PDF-Datei mit Ihrem 
Standard-PDF-Einstellungen (wie bei der Verwendung von Direktes Exportieren als PDF). Es 
öffnet sich Ihr Email-Programm mit der angehängten PDF-Datei.

Sie können ein Dokument an mehrere Empfänger E-Mails versenden. Weitere Informationen 
finden Sie in Kapitel 10 - Drucken, Exportieren und E-Mailen im Erste Schritte Handbuch.
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